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AKTUELLE PRAXISBERICHTE RUND UM MODERNES INSTANDHALTUNGSMANAGEMENT
»» Die»Rolle»der»Instandhaltung»in»Zeiten»von»Industrie»4.0
»» Ansätze»gegen»den»Fachkräftemangel»–»Qualifizierung»und»Mitarbeiterentwicklung»
»» Kunde»Produktion:»Anforderungen»an»eine»flexible,»bedarfsgerechte»Instandhaltung
»» Big»Data»in»der»Praxis»–»Data»Analytics»als»Schlüssel»zu»mehr»Transparenz»und»»

verbesserten»IH-Entscheidungen
»» Risk»vs.»Reliability?»Formulieren»von»differenzierten»IH-Strategien»für»das»Anlagenportfolio
»» Reorganisation»der»Instandhaltung»–»zentral»oder»dezentral?»Optimierungspotenziale»nutzen
»» Arbeitsvorbereitung:»Ressourcensteuerung»durch»modernes»Planning»&»Scheduling
»» Von»Mobile»zu»Augmented»Reality»und»Sprach-/Gestensteuerung»–»was»kommt,»was»ist»heute»

schon»möglich?
»» Rechtssicherheit:»Umsetzung»der»novellierten»BetrSichV»und»der»CE-Verordnung
»» Vergabe»der»Instandhaltung»an»einen»Fullservice-Partner»–»wie»kann»das»organisatorisch»

umgesetzt»werden»und»wie»funktioniert»die»Vergütung?
»» Zuverlässigkeitsorientierte»Instandhaltung:»Condition»Monitoring»richtig»eingesetzt!

MAINDAYS 

Melden»Sie»sich»an:
www.maindays.de

16. – 17. März 2016, Berlin

2016

PLUS: Intensiv-Workshop am 15. März 2016
Risikoorientiertes»IH-Management»–»strategischer»Erfolgs-»
faktor»für»Anlagenverfügbarkeit»und»Kostenoptimierung»
PLUS: Diskussionen zu den Top-Themen der Instandhaltung

PLUS: Verleihung des MAINTAINERS 2016
PLUS: Spannende Keynotes aus der Industrie
PLUS: Gemeinsamer Abendausflug zum Networken
PLUS: Fachforen mit Best-Practice-Vorträgen

AUSSTELLER

KOOPERATIONSPARTNER MEDIENPARTNER

Digitale Transformation: Asset Management im Wandel



WER SOLLTE TEILNEHMEN? 

Diese»Tagung»ist»ein»Muss»für»Verant-
wortliche»rund»um»das»technische»
Asset»Management,»insbesondere»

»» Instandhaltung
»» Technik
»» Technischer»Service
»» Instandhaltungsplanung
»» Technisches»Controlling

sowie»Werks-/Betriebsleiter»und»
Produktion.

die»Ansätze»rund»um»Industrie»4.0»bieten»nicht»zu»unterschät-
zendes»Potenzial»für»Veränderung:»intelligente,»digital»vernetzte»
Informations-»und»Kommunikationssysteme»ermöglichen»die»
Selbstorganisation»von»Produktionseinheiten»und»beeinflussen»
die»Mensch-Maschine-Interaktion.»Die»modernen»Produktions-
landschaften»stellen»damit»neue»Anforderungen»an»das»Asset»
Management»und»die»Instandhaltung:»Störungsmeldung»und»
-behebung»erfolgen»in»Echtzeit,»Instandhaltungsteams»haben»
Zugriff»zu»Daten»aus»verschiedenen»Quellen»und»sind»in»der»Lage,»
Arbeitspakete»und»das»Scheduling»selbstbestimmt»zu»steuern.»
Condition»Monitoring,»mobile»Applikationen»und»neue»Techno-
logien»wie»Virtual»Reality»werden»dabei»zu»Schlüsselfunktionen.»

Voraussetzung»für»die»„Maintenance»4.0“»ist»jedoch,»dass»die»
Grundlagen»und»Kernthemen»der»Instandhaltung»wirklich»be-
herrscht»werden»–»passgenaue»Festlegung»der»Instandhaltungs-
strategie»für»die»einzelnen»Assets,»systematische»Fehleranalysen»
zur»Reduzierung»von»Störungen,»Erhöhung»des»Anteils»der»ge-
planten»Instandhaltung»und»die»Einhaltung»eines»komplexen»
Normengeflechts»sind»ein»Muss!»

Auch»Sie»stehen»nun»vor»der»Herausforderung,»Ihre»Stra-
tegien,»Prozesse»und»Strukturen»auf»Tauglichkeit»für»neue»
Anforderungen»hin»zu»überprüfen.»Erfahren»Sie»auf»den»
MainDays 2016,»an»welchen»Themen»namhafte»Unterneh-
men»heute»arbeiten,»um»fit»für»die»Welt»von»morgen»zu»sein.

Von»flexiblen»IH-Strategien»und»Change»Management»über»
Ansätze»gegen»den»drohenden»Fachkräftemangel»bis»hin»zu»
Data»Analytics»und»dem»Einsatz»mobiler»Technologien»–»Sie»
bekommen»das»Rüstzeug,»das»Sie»für»eine»zeitgemäße»Instand-
haltung»benötigen.»Lernen»Sie,»»
»» wie»Sie»Reorganisationsprojekte»stimmig»aufsetzen»und»

damit»auch»die»richtigen»Stellhebel»für»Prozessoptimierung»
und»Kostensenkung»in»Gang»setzen

»» wie»Sie»ein»globales»Maintenance-Netzwerk»steuern»und»
dabei»auch»Standortunterschiede»berücksichtigen»

»» welche»innovativen»Tools»im»Fahrwasser»von»Industrie»4.0»
entwickelt»werden»und»wie»sie»die»Arbeitsweisen»in»der»
Instandhaltung»»heute»schon»verändern»

»» wie»ein»risikobasierter»Ansatz»dabei»helfen»kann,»dass»eine»
flexible»Anpassung»der»Instandhaltung»an»Markterforder-
nisse»gelingt

»» wie»Sie»den»Service-Gedanken»in»Ihren»Maintenance-Teams»
verankern»und»damit»eine»Neupositionierung»erreichen

»» wie»3D-Produktvisualisierung»komplexe»Maintenance-
Prozesse»unterstützen»kann

»» welche»Tools»SAP»zur»Umsetzung»eines»modernen,»inte-
grierten»Asset»Management»bereitstellt»und»wie»diese»in»
die»bestehende»IT-Landschaft»eingebunden»werden»können

»» welche»Auswirkungen»der»Megatrend»„Mobile“»mit»Smart-
phones,»Sensoren»und»Big»Data»auch»auf»Ihre»Geschäfts-
prozesse»haben»wird»

»» wie»Condition»Monitoring»»mithilfe»von»RCM»wirtschaftlich»
eingesetzt»werden»kann

»» wie»Sie»ein»funktionierendes»Kennzahlensystem»aufbauen.»

Aktuelle Fachforen – Sie haben die Qual der Wahl!
Nutzen»Sie»unsere»verschiedenen»Foren»und»stellen»Sie»sich»Ihr»
persönliches»Tagungsprogramm»selbst»zusammen.»Zahlreiche»
Praxisberichte»rund»um:

»» Störungsminimierung»durch»Smart»Maintenance
»» Risk»versus»Reliability»–»IH-Strategie»und»Budgetierung
»» Rechtssicherheit»von»IH-Organisation»und»-Prozessen
»» Reorganisation»und»Change»Management

helfen»Ihnen»dabei,»Ihre»Instandhaltung»auf»den»neuesten»Stand»
zu»bringen.»

MAINTAINER 2016
Ein»besonderer»Höhepunkt»ist»wieder»die»Verleihung»des»
MAINTAINERS»2016,»dem»‚Oscar’»der»Instandhaltung.»Die»
Preisträger,»drei»von»unserer»Jury»ausgewählte»und»prämierte»
Unternehmen,»stellen»ihre»Projekte»vor.»Dabei»werden»wieder»
auch»innovative»Dienstleistungen»und»Projekte»berücksich-
tigt.»Haben»Sie»selbst»eine»neue»Idee»rund»um»die»Instand-
haltung»pfiffig»umgesetzt?»Machen»Sie»mit»und»bewerben»
Sie»sich»bis»zum»29. Januar 2016.»Weitere»Informationen»
dazu»finden»Sie»auf»Seite»7.

Ich»freue»mich»auf»ein»Wiedersehen»in»Berlin

Sehr geehrte
Damen und Herren,

Abendveranstaltung am 16. März 2016

T.A. Cook lädt Sie zu einem geselligen Abend ein!
Lassen»Sie»sich»überraschen!»Nach»einem»informativen»und»spannenden»ersten»Konferenztag»möchten»wir»Sie»zu»einer»
exklusiven»Abendveranstaltung»mitten»im»Herzen»von»Berlin»einladen.»Vertiefen»Sie»die»Themen»des»Tages»und»knüpfen»
Sie»wertvolle»Kontakte.»Detaillierte»Informationen»erhalten»Sie»in»Kürze»auf»www.maindays.de

Treffpunkt:»Um»19.00»Uhr»treffen»wir»uns»in»der»Hotellobby.»
Dresscode:»sportlich,»legere»Abendkleidung

DIE AUSZEICHNUNG FÜR HERAUSRAGENDE INSTANDHALTUNG
MAINTAINER 2016

Wichtige»Hinweise»zum»
MAINTAINER»auf»Seite»7



Intensiv-Workshop | Dienstag, 15. März 2016
Zeitlicher Ablauf: 09.30»Beginn»des»Workshops»|»12.30»Gemeinsames»Mittagessen»|»17.00»Ende»des»Workshops
Hinweis: Die»Teilnehmerzahl»ist»im»Interesse»des»Workshop-Charakters»begrenzt.

Zielsetzung 
Besonders»in»den»Bereichen»hoch»wertschöpfender»Risiko-»und»Engpass-Anlagen»
sowie»-Prozessen»mit»hohen»Gefährdungs-,»Kritikalitäts-»und»Produktivitätsausfall-
Potenzialen»sind»messbar»hohe»Einsparungs-»und»Nutzenpotenziale»nachhaltig»
realisierbar.»Gleichzeitig»können»verfügbare»Ressourcen-»und»Mitteleinsätze»(Kosten)»
optimiert»bzw.»strukturell»gesenkt»werden.

Der»Workshop»ist»als»Impulsgeber,»Fach-»und»Praxisforum»zur»gemeinsamen»Analyse,»
kritischen»Bewertung»und»Diskussion»bei»der»strategischen»Ausrichtung,»Organi-
sation»und»ergebniswirksamen»Umsetzung»risikoorientierter»IH-Strategien»und»
Lösungsmodellen»konzipiert.»Er»unterstützt»eigene»Optimierungsmaßnahmen»des»
IH-Prozesses»im»Unternehmen»der»Teilnehmer.

Zielgruppe
Mitarbeiter»und»Führungskräfte,»insbesondere»aus»Technik,»Instandhaltung,»Asset»
Management»und»technischem»Service,»die»sich»mit»der»Entwicklung»und»For-
mulierung»von»Instandhaltungsstrategien»in»einem»verfügbarkeitsorientierten»
Umfeld»beschäftigen.

Agenda/Inhalte
»» Welches»sind»die»strategischen»Ziele,»Erfolgsparameter»und»Steuerungs-

größen»im»modernen»life-cycle-basierten»Asset-Management-Prozess?
»» Strategien,»Status»und»Leistungen»des»Instandhaltungsprozesses»heute
»» Wie»werden»Risiko-/Engpass-Anlagen»und»-Prozesse»sowie»aktuelle»

Gefährdungs-,»Kritikalitäts-»und»Produktivitätsverlust-Potenziale»im»
Wertschöpfungsprozess»ermittelt»und»bewertet?

»» Anforderungen»an»das»Daten-»und»Dokumentenmanagement»risk-
basierter»Anlagen,»Prozesse»und»Objekte

»» Strategische»minimale»Entstörzeitvorgaben:»Basis»und»zentrale»Leitgröße»
zur»Definition,»Konzeption,»Budgetierung»und»Organisation»des»risk-»&»
objektbezogenen»strategischen»Instandhaltungsprozesses

»» Erfolgsfaktor:»Maschinen-,»Betriebs-,»Prozess-»und»Stördatenerfassung
»» Kommunikation»zwischen»Produktion,»Instandhaltung»und»Engineering
»» Die»Rolle»der»IH-Planung»und»Arbeitsvorbereitung»in»Risiko-»und»Eng-

passbereichen
»» Störungsmanagement»und»KVP-Prozesse»im»Bereich»von»Risk-Anlagen
»» Bewertete»Standardarbeitspläne»für»Risiko-Anlagen»und»-Prozesse
»» Ziele»und»Handlungsrahmen»risk-basierter»Material-»und»Ersatzteilewirt-

schaft»
»» Der»Melde-»&»Auftragsprozess»für»risk-basierte»IH-Aufträge
»» Berichtswesen,»Kenn-»&»Leistungszahlen»sowie»Controlling»von»risk-

basierten»Anlagen»und»Prozessen
»» Outsourcing»von»IH-Aufträgen»an»Risiko-»und»Engpass-Anlagen…»eine»

Option?
»» Erfolgsfaktor:»Führung»&»Mensch/Change»Management
»» Aufwand»und»Nutzenbetrachtung»im»risikoorientierten»IH-Management

Fachliche Leitung und Moderation

GÜNTER»RÖSSLER»erwarb»nach»seinen»Studien»langjährige»Führungserfahrung»in»
verantwortlichen»Linienfunktionen»der»Prozess-»und»Investitionsgüterindustrie.»
Ab»1974»leitete»er»als»Gesellschafter»und»Partner»der»FRASER»Unternehmensbe-
ratung»GmbH»in»den»Bereichen»Instandhaltung,»Produktion,»Logistik»und»techni-
sche»Betriebsführung»ergebnisverantwortlich»erfolgreiche»Reorganisations-»und»
Restrukturierungsprojekte»nationaler»und»internationaler»Unternehmen.»Seit»1989»
führt»Günter»Rössler»als»Senior»Consultant»die»R»&»P»CONSULT»Unternehmensbe-
ratung,»Hattingen,»mit»anspruchsvollen»IH-Beratungsprojekten»zur»Optimierung»
der»integrierten»Instandhaltung»und»Anlagenwirtschaft.»Zudem»referiert»er»seit»
mehr»als»25»Jahren»bei»führenden»deutschen»und»europäischen»IH-Fachverbänden,»
Instituten»und»Veranstaltern.

Risikoorientiertes Instandhaltungsmanagement –  
strategischer Erfolgsfaktor für Anlagenverfügbarkeit und Kostenoptimierung

Auch einzeln buchbar!

Kooperationspartner
Das»Forum Vision Instandhaltung e. V.»hat»sich»seit»seiner»Gründung»im»Jahr»2004»zum»anerkannten»Sprachrohr»der»
industriellen»Instandhaltung»entwickelt.»Es»ist»initiativ»bei»Politik,»Industrie,»Forschung»und»Lehre»und»strebt»die»Stärkung»
der»Brancheninteressen»auf»nationaler»sowie»europäischer»Ebene»an.»Im»Fokus»stehen»die»Themen»innovative»Technologien,»
Wissenstransfer,»Forschung,»Seminare»und»Weiterbildung.
www.fvi-ev.de

Das»Fachmagazin»Instandhaltung»befasst»sich»mit»dem»Management»und»dem»Service»von»Maschinen,»Anlagen»und»Indus-
triebauten»aller»Branchen.»»Neben»der»Vorstellung»neuer»technischer»Verfahren,»Ausrüstungen»und»Werkzeuge»werden»auch»
Lösungen»zum»Industrial»Asset»Management»praxisnah»dargestellt.
www.instandhaltung.de

Ziel»des»gemeinnützigen»Vereins»MFA – Maintenance and Facility Management Society of Austria»ist»der»internatio-
nale»praxisorientierte»Wissensaustausch»zwischen»Wirtschaft»und»Wissenschaft»in»den»Bereichen»Instandhaltung,»Facility»
Management»und»Technischer»Service.»Die»MFA»versteht»sich»als»Informations-»und»Kommunikationsplattform»und»bietet»
ihren»Mitgliedern»eine»Vielzahl»an»Leistungen»an.»Der»Verein»ist»die»offizielle»österreichische»Repräsentanz»im»europäischen»
Netzwerk»der»EFNMS»(www.efnms.org).»Alle»Infos:»
www.mf-austria.at»

Der»Wirtschaftsverband für Industrieservice e. V. (WVIS) ist»eine»branchenübergreifende»Interessenvereinigung»für»
Unternehmen»im»Industrieservice.»Zielsetzung»des»WVIS»ist»es,»die»wirtschaftspolitischen»Interessen»der»wachstumsstarken»
Branche»Industrieservice»zu»artikulieren»und»in»enger»Zusammenarbeit»mit»den»Mitgliedsunternehmen»Qualität»und»Nach-
haltigkeit»über»einheitliche»Standards»und»ein»gemeinsames»Branchenbild»zu»schaffen.
www.wvis.eu



Fachtagung: 1. Tag | Mittwoch, 16. März 2016

IH-Strategie zwischen Werterhalt und Kosten
Was»sind»die»relevanten»Ziel-»und»Steuerungsgrößen?»|»Wie»kann»man»
Größen»wie»Werterhalt»oder»Wertschöpfungsbeitrag»sichtbar»machen?»|»»
Instandhaltung»und»IH-Strategien»|»Herausforderung»im»Ersatzteil-»
management»|»Ansätze»zur»Risikobewertung»|»Praxisbeispiele»und»Fazit
Friedhelm»Iske,»Leitung»Instandhaltung,»Hydro»Aluminium»Rolled»»
Products»GmbH

Risk versus Reliability – flexible Anpassung der Instand-
haltungsstrategien an das Marktumfeld
Risiko»und»dessen»Bestimmung»|»Risikobasierte»Instandhaltung»als»Teil»
des»Asset»Management»Systems»|»Flexible»Anpassung»der»Instandhaltung
Dr.»Markus»Göring,»Risk-based»Maintenance»Expert,»Vattenfall»Wärme»
Hamburg»GmbH

Risikoorientierte Instandhaltung – Ansätze zur Budge-
tierung
Bisherige»Vorgehensweise»der»Budgetierung»|»Methode:»historische»
Abschätzung»|»Methode:»Risikoorientierte»Abschätzung»|»Einbindung»
in»den»Planungsprozess
Holger»Schrimpf,»Unterabteilungsleiter»mechanische»Instandhaltung,»
und»Alexander»Seele,»Technischer»Sachbearbeiter,»beide»Volkswagen»AG»

08.30 Check-in und Ausgabe der Tagungsunterlagen

09.00 Begrüßung und Eröffnung durch den Vorsitzenden
Thomas»Cook,»Geschäftsführer,»T.A.»Cook»Conferences

09.10 Industrie 4.0 als alleiniger Segensbringer – oder was sonst noch?
Müssen»wir»uns»neu»mit»den»Zielen»der»Instandhaltung»auseinandersetzen»und»welche»Herausforderungen»kommen»auf»uns»zu?»|»Was»sind»die»Kriterien»
für»eine»erfolgreiche»Instandhaltung?»Was»ändert»sich»an»der»Schnittstelle»Betreiber/technischer»Dienstleister?»|»Welche»Relevanz»kommt»hierbei»dem»
Thema»Arbeitssicherheit»zu?
Dr.»Clemens»Mittelviefhaus,»Mitglied»der»Geschäftsführung,»InfraServ»GmbH»&»Co.»Knapsack»KG

10.00 Reorganisation der Instandhaltung – Stellhebel für nachhaltige Prozessoptimierung und Kostensenkung
Wie»lassen»sich»Verbesserungspotenziale»in»den»Prozessen»erkennen»und»»ausschöpfen?»|»Zentral»oder»dezentral?»Organisation»als»Ausgangspunkt»für»
schlanke»Prozesse?»|»Gelebte»Prozesse»-»neue»Anforderungen»an»die»Mitarbeiter:»Change»Management»zur»Unterstützung»von»Veränderungsprozessen»|»»
Steuerung»durch»Prozesskennzahlen»|»Schnellere»und»schlankere»Prozesse»–»aber»nicht»auf»Kosten»von»Qualität»und»Sicherheit
Karl-Jochen»Riehm,»Field»Maintenance»Superintendent»GasWest,»ExxonMobil»Production»Deutschland»GmbH;»Uwe»Sahl,»Senior»Manager,»»
T.A.»Cook»Consultants

10.45 Kaffeepause und Gelegenheit zum Besuch der Ausstellung

11.15 Lokal versus global? Steuern eines globalen Maintenance-Netzwerks
Aufbau»eines»Netzwerkes»über»Standorte»und»Ländergrenzen»hinweg»|»Steuerungswerkzeuge»|»Strategische»Kennzahlen»–»Transparenz,»Vergleichbarkeit,»
Akzeptanz»|»»Best»Practice»Sharing»|»Kommunikation»und»Kulturunterschiede»|»Knowledge»Management
Dr.»Ingo»Thorwest,»Leiter»Global»Maintenance,»Corporate»Engineering»&»Infrastructure,»Boehringer»Ingelheim»Pharma»GmbH»&»Co.»KG

12.00 Formulieren einer Strategie gegen den Fachkräftemangel – Mitarbeiterauswahl und -entwicklung
Eignungsdiagnostische»Verfahren»|»Dimensionen,»Kompetenzmodell»und»Zielkreis»|»Change»Management»|»Personalentwicklung»|»Veränderungsbereitschaft»|»»
Mitunternehmertum»|»Kommunikation
Dr.»Christoph»Herzog,»Abteilungsleiter»TP»(Technik/Planung),»regionetz»GmbH

12.40 Mittagspause und Gelegenheit zum Besuch der Ausstellung

16.00 Kaffeepause und Gelegenheit zum Besuch der Ausstellung

16.30 Megatrend Mobile – wie Smartphones, Sensoren und Big Data die Unternehmen wirklich verändern werden
Wie»sich»die»Digitalisierung»im»B2B»und»B2C»auswirken»wird»|»Wie»die»zweite»industrielle»Revolution»Marktmacht»völlig»neu»verteilen»wird»|»Auf»welche»
Weise»Daten»das»zukünftige»Geschäft»bestimmen»werden»|»Warum»diese»Entwicklung»auch»in»der»Instandhaltung»keinen»Stein»auf»dem»anderen»lassen»wird
Prof.»Dr.»Key»Pousttchi,»Lehrstuhl»für»Wirtschaftsinformatik»und»Digitalisierung,»Universität»Potsdam»

17.15 Preisverleihung des MAINTAINERS 2016 und Kurzvorstellung der prämierten Konzepte
»» MAINTAINER»–»Projekt»des»Jahres/Industrieunternehmen
»» MAINTAINER»–»Projekt»des»Jahres/Dienstleister
»» MAINTAINER»–»Sonderpreis»für»Innovation

18.15 Ende des ersten Veranstaltungstages

14.00

Keynote

Zuverlässigkeitsorientierte Instandhaltung: Condition 
Monitoring richtig eingesetzt! Praxisbeispiel Großkran in der 
Stahlindustrie
Wie»kann»der»wirtschaftliche»Einsatz»von»Condition»Monitoring»systematisch»
mit»der»RCM-Methode»abgeleitet»werden?»|»Grenzen»der»manuellen»Inspek-
tion»oder»des»vorbeugenden»Austausches»von»Baugruppen»|»Auswahl»eines»
Condition»Monitoring»Systems»für»Schwerlastantriebe»|»Wie»funktioniert»das»
gewählte»System»in»der»Praxis»und»welche»Schäden»konnten»schon»erfolgreich»
vor»Bauteilausfall»erkannt»werden?
Dr.»Michael»Holtmann,»Leiter»Instandhaltung»Schmelzbetrieb,»Hüttenwerke»
Krupp»Mannesmann»GmbH

Equipment Improvement – Ausschließen von Fehlerquellen am 
Beispiel Rotating Equipment 
Typische»Fehlerquellen»im»System»Kreiselpumpen»|»Mögliche»Instandhaltungs-
strategien»|»Technische»Ansatzpunkte»um»Fehlerquellen»zu»reduzieren»|»Eigen-
sichere»Spezialkreiselpumpen»|»Fallbespiele»(Kondensatanlage,»Slopsystem,»
Tankwagenentladung)
Sadko»Meusel,»Vertriebsingenieur,»Paul»Bungartz»GmbH»&»Co.»KG;»Peter»Michael»
Rainer,»Leiter»Rotating»Equipment,»Total»Raffinerie»Mitteldeutschland»GmbH

Praktische Erfahrungen bei der Umsetzung einer mobilen 
Instandhaltung auf Basis SAP PM 
Saubere»Erfassung»von»Stammdaten»|»Wartungsabwicklung»durch»Bediener»
oder»Instandhaltung»|»Verkürzen»der»Reaktionszeiten»bei»Störungen»|»Schaffen»
von»Transparenz»im»IH-Prozess
Stefan»Willner,»Leitung»Instandhaltung,»Siemens»AG»-»Gerätewerk»Erlangen

Forum  Risikobasierte IH-Strategie und Budgetierung Forum  Smart Maintenance – Störungen minimieren

Keynote



Fachtagung: 2. Tag | Donnerstag, 17. März 2016
09.00 Begrüßung durch den Vorsitzenden

Thomas»Cook,»Geschäftsführer,»T.A.»Cook»Conferences

09.10 Data-Driven-Services: Digitalisierung in der Prozessindustrie
Wie»wird»„Industrie»4.0“»für»Industrieunternehmen»greifbar?»|»Neue»Anforderungen»an»Flexibilität»und»Vernetzung»entlang»der»Wertschöpfungskette»|»»
Instandhalter»als»Schlüsselrolle»im»Transformationsprozess»|»Data»Analytics»als»Schlüssel»|»Erste»Erfahrungen»mit»Pilotprojekten»–»wie»geht»es»weiter?
Dr.»Andreas»Weber,»Vice»President»Business»Development,»Evonik»Technology»&»Infrastructure»GmbH

10.00 Assistiertes, mobiles Arbeiten im demographischen Wandel – Einsatz einer portablen Lern- und Wissensplattform
Konservierung»von»Erfahrungswissen»älterer»Mitarbeiter»|»Komplexe»technische»Anlagen»im»generationsübergreifenden»Langzeit-Einsatz»|»Integration»
von»Methoden»für»den»Wissenstransfer»in»die»Unternehmensprozesse»|»Anbindung»an»SAP»Instandhaltungs-»und»Dokumentenmanagementsysteme»|»»
Mobile»Assistenten»mit»Augmented»Reality
André»Fiedler,»Projektleiter,»Condat»AG;»Enrico»Powdrack,»Teamleiter»Komponenteninstandsetzung»U-Bahn,»Berliner»Verkehrsbetriebe»(BVG)

10.45 Kaffeepause und Gelegenheit zum Besuch der Ausstellung

11.15 Gegenwart und Zukunft im SAP-gestützten Asset Management – Wunsch und Wirklichkeit aus der Anwenderperspektive
Wo»stehen»die»Unternehmen»heute?»Was»tut»SAP»für»diese»Unternehmen?»|»Vor»welchen»Herausforderungen»stehen»die»Unternehmen?»Welche»Trends»
setzt»SAP?»|»»Stichwort»Nutzerakzeptanz:»Wie»schaffen»Sie,»dass»Ihre»Anwender»mitziehen?
Prof.»Dr.»Karl»Liebstückel,»Laborleiter»SAPLab,»Hochschule»für»angewandte»Wissenschaften»Würzburg-Schweinfurt

12.00 Round-Table-Diskussionen»eröffnen»Ihnen»die»Möglichkeit,»sich»in»einem»kleineren»Kreis»mit»Gleichgesinnten»unter»Leitung»eines»Experten»auszu-
tauschen.»Abseits»der»Präsentationen»haben»Sie»hier»die»Chance,»Ihre»Fragestellungen»mit»Fach-»und»Führungskräften»zu»diskutieren,»die»vor»ähnlichen»
Herausforderungen»im»betrieblichen»Alltag»stehen.

15.15 Kaffeepause und Gelegenheit zum Besuch der Ausstellung

15.30 Praxisbeispiel Siemens Schienenfahrzeugwerk: Vergabe der Instandhaltung an einen Fullservice-Partner
Aufbau»einer»eigenständigen»Instandhaltungsorganisation»mit»allen»instandhaltungsrelevanten»Funktionen?»|»Definition»von»Schnittstellen»und»Verantwortlich-
keiten»(was»macht»der»Kunde,»was»macht»der»Dienstleister?)»|»Vergütungsansätze»|»Inwieweit»kann»von»einer»Selbstorganisation»des»Dienstleisters»ausgegangen»
werden?»|»Wer»die»Daten»hat,»hat»die»Macht:»Wer»hat»die»Datenhoheit»und»wie»wird»der»Datenbestand»im»ERP»geregelt?
Dirk»Lorenz,»Niederlassungsleiter,»und»Andreas»Wokittel,»Mitglied»der»Geschäftsleitung,»SPIE»GmbH

16.15 Zusammenfassung und Verabschiedung

Keynote

Keynote

Mobile Einsatzplanung & Ressourcen-
steuerung – was ist zu beachten?

Richtig Steuern! Erfolgsfaktoren für
den Aufbau eines funktionierenden 
Kennzahlensystems

IH-Planung & Arbeitsvorbereitung:  
Was und „wie viel“ benötigen wir  
davon im IH-Prozess?

Moderation:»Stephan»Vogel,»Manager,»
T.A.»Cook»Consultants

Moderation:»Ruud»Kockelkorn,»
Vorstandsvorsitzender,»Peach»Group»B.»V.

Moderation:»Günter»Rössler,»Senior»»
Consultant,»R»&»P»CONSULT

12.45 Mittagspause und Gelegenheit zum Besuch der Ausstellung

BetrSichV & CE-Kennzeichnung: Was muss unbedingt 
beachtet werden?
Aufgaben»der»Instandhaltung»und»relevante»Normen»|»Novellie-
rung»der»BetrSichV»–»Auswirkungen»|»Maschinenrichtlinie»und»
CE-Kennzeichnung:»Wo»lauern»die»Fallstricke?»|»Rechtskonformes»
Handeln»in»der»Instandhaltung»etablieren
Helmut»Bach,»Leiter»technische»Maschinensicherheit,»»
ZF»Friedrichshafen»AG

Aufbau einer rechtssicheren IH-Dokumentation im 
Sinne der BetrSichV
Motivation»|»Kritikalitätsanalyse»von»Anlagen»|»Failure»Mode»and»
Effects»Analysis»|»Von»der»FMEA»zur»dokumentierten»Strategie»|»»
Vorstellung»im»Produktivsystem»Bayer
Peter»Rau,»Betriebsleiter»Technical»Storage»und»Reliability»»
Manager,»Bayer»CropScience»AG

Zentralisierung der Instandhaltung und Auswirkung auf die Pro-
duktion in der Umstellungsphase
Verfügbarkeitsorientierte»IH-Strategie»|»Kennzahlen»in»der»Praxis»|»Instandhaltung»
als»Prozess»|»Reorganisation»der»IH»von»dezentral»auf»zentral»|»Synergieeffekte»durch»
Zentralisierung»|»Auswirkung»auf»den»Betreiber
Stefan»Mian,»Leiter»produktionsnahe»Instandhaltung,»Refining»Technologies,»»
Grace»GmbH»&»Co.»KG

Der Kunde ist König? – Entwicklung des Kundenservice in einer 
internen Instandhaltung
Ausgangspunkt»der»Überlegungen»–»Anstoß»zu»neuem»Denken»|»Erste»Schritte»–»»
Was»macht»guten»Service»in»der»Instandhaltung»aus?»|»Der»interne»Kunde»–»
eine»Neupositionierung»|»Kommunikation»–»intern»und»zum»Kunden»|»Weitere»»
Aussichten»–»es»bleibt»weiterhin»spannend
Lothar»Schmiegel,»Leiter»Instandhaltung,»Gerolsteiner»Brunnen»GmbH»&»Co.»KG

13.45 Forum   Rechtssichere IH-Organisation & -Prozesse Forum  Reorganisation & Change Management



Aussteller
Die»Firma»Bungartz»ist»ein»Hersteller»von»Spezialkreiselpumpen»für»schwierige»und»hochverfügbare»Anwendungen.»Durch»Sonderphysik»
und»konstruktive»Alleinstellungsmerkmale»kann»auf»übliche»Maßnahmen»zur»Überwachung»und»Einbindung»einer»Pumpe»(Zulaufhöhen,»
Entlüftung,»Trockenlaufschutz,»Filter,»Mindestvolumenstrom,»Regelung»etc.)»verzichtet»werden.»Im»Ergebnis»gibt»es»dadurch»weniger»
Fehlerquellen»im»System»Pumpe»und»der»Instandhaltungsaufwand»reduziert»sich»enorm.»
www.bungartz.de

Die»Berliner»Condat AG»entwickelt»IT-Lösungen»für»komplexe»Planungsprozesse.»Zu»unseren»Kunden»gehören»Medienunternehmen,»
Telekommunikationsanbieter»und»Hersteller»von»Maschinen»und»Anlagen.»Skyware»Dispatch»ist»unser»innovatives»Produkt»für»die»
Steuerung»des»Außendienstes.»Die»grafische»Plantafel»von»Skyware»Dispatch»stellt»dem»Disponenten»jederzeit»den»aktuellen»Auslastungs-»
und»Planungsstand»dar.»Auf»der»geografischen»Karte»werden»Routen»optimiert,»Einsatzzeiten»überwacht»und»wichtige»Information»
dargestellt.»Nur»wer»seine»Instandhaltungs-»und»Serviceprozesse»im»Griff»hat,»kann»Kundenerwartungen»erfüllen»und»Wachstum»sichern.
www.condat.de

Wir»präsentieren»Foamglas®»als»Dämmstoff»im»Maintenance»Bereich,»Formteile»und»Beschichtungen»für»Behälter»und»Rohrleitungen»
mit»Betriebstemperaturen»von»-273»bis»430°C.»Vermeidung»von»Korrosion»unter»der»Dämmung»(diffusionsdicht),»Brandschutzlösungen»
(nichtbrennbar,»BStkl.»A1)»»Anwendungen»als»Tankbodendämmung»(druckfest)»vom»Wärmespeicher»bis»zum»LNG-Tank»und»erdverlegte»
Leitungen.»Höchste»Produktqualität»und»70»Jahre»Erfahrung»auf»den»internationalen»Anwendungsgebieten.
www.foamglas.com

PeachGroup»ist»einer»der»führenden»Beratungspartner»im»Bereich»des»Betriebsmittel-»und»Anlagenmanagements.»Unsere»Erfolge»bei»der»
Erarbeitung»von»Leistungen»und»Lösungen»werden»von»immer»mehr»Kunden»anerkannt.»Wir»haben»verschiedene»erfolgreiche»Projekte»
in»den»Bereichen»Ersatzteilmanagement,»Service»mit»SAP»CS,»Instandhaltung»und»Kennzahlen»in»der»Instandhaltung»durchgeführt.
www.peachgroup.de

PRÜFTECHNIK»Dieter»Busch»AG»ist»einer»der»weltweit»führenden»Anbieter»von»hochwertigen»Prüf-»und»Messsystemen»sowie»Dienst-
leistungen»für»die»industrielle»Instandhaltung»und»Qualitätssicherung.»Mit»über»600»Mitarbeitern»entwickelt,»produziert»und»vertreibt»
das»Unternehmen»seit»1972»Produkte»und»Lösungen»für»laseroptisches»Ausrichten,»Condition»Monitoring»und»die»zerstörungsfreie»
Prüfung»von»metallischen»Halbzeugen.
www.pruftechnik.de

T.A. Cook ist»eine»weltweit»tätige»Beratungsboutique»für»Asset»Performance»Management.»Kernkompetenz»der»Managementberatung»
ist»die»nachhaltige»Implementierung»von»Operational»Excellence»Practices»in»der»anlagenintensiven»Industrie.
www.tacook.com

Ausstellung
Wollen»Sie»als»Anbieter»mit»potenziellen»Kunden»und»Partnern»in»Kontakt»kommen?»Unsere»aktuelle»Instandhaltungs-
tagung»MAINDAYS 2016»bietet»Ihnen»die»geeignete»Plattform,»Ihre»Leistungen»und»Produkte»vorzustellen.»Mit»einem»
Ausstellungsstand»stellen»Sie»Ihre»Kompetenz»im»professionellen»Umfeld»unter»Beweis,»treten»in»direkten»Kontakt»zu»
einem»ausgewählten»und»für»Sie»interessanten»Publikum,»erhöhen»den»Bekanntheitsgrad»Ihres»Unternehmens»und»
können»zielgerichtet»ein»spezielles»Produkt»oder»eine»Dienstleistung»fördern.

Ansprechpartner:  
Peter»Ziegler»|»Senior»Sponsorship»Manager»|»Tel.:»+49»(0)30»88»43»07»25»|»E-Mail:»p.ziegler@tacook.com

www.bungartz.de
www.condat.de
http://www.foamglas.com
www.peachgroup.de
www.pruftechnik.de
www.tacook.com


B&I Die Industrie-Zeitung»mit»dem»Themenspecial»Industrie-Service»und»den»Sonderteilen»CONDITION»MONITORING»&»ENERGIE»
EFFIZIENZ.»Praxisnahe»Anwenderreportagen»&»aktuelle»Produktberichte»aus»elf»Sachgebieten»unterstreichen»die»Kompetenz»der»
Zeitung»&»geben»permanent»Impulse»für»Investitionen.»6»Ausgaben»pro»Jahr.»Auch»online»mit»den»Schlagzeilen»des»Tages.»
www.b-und-i.de

CHEManager»ist»das»führende»Fachmedium»für»die»Chemie-,»Pharma-»und»Prozessindustrie»im»deutschsprachigen»Raum.»Die»Zeitung»
und»die»ergänzenden»Online-Services»werden»abteilungsübergreifend»von»Geschäftsführern,»Entscheidern»und»Investitionsverant-
wortlichen»der»genannten»Branchen»gelesen.»
www.chemanager-online.com

Der Betriebsleiter»wendet»sich»mit»einer»Druckauflage»von»20.000»Exemplaren»an»Verantwortliche»für»Produktion»und»Betrieb»sowie»
technische»Führungskräfte»in»der»Industrie.»Die»Empfänger»sind»Entscheider»mit»Investitionskompetenz»für»alle»Bereiche»im»Betrieb»
und»im»Produktionsprozess.»Das»polytechnische»Medium»erscheint»9-mal»jährlich»und»fokussiert»entscheiderorientierte»Themen»auf»
Sicherheit,»Effizienz»und»Nachhaltigkeit»in»der»Produktion.
www.derbetriebsleiter.de

Industrie 4.0 Management»verfolgt»eine»integrierte»Betrachtung»von»Strategien,»Organisation»und»Rechnereinsatz»bei»Auftrags-
durchlauf»und»Produktentwicklung»und»bietet»eine»einzigartige»Sicht»auf»alle»industriellen»Geschäftsprozesse»in»der»Gegenwart»und»
in»der»Zukunft.»
www.industrie40-management.de

VDI nachrichten»ist»die»führende»meinungsbildende»Wochenzeitung»für»Ingenieure»und»das»Technische»Management.»Freitags»
berichtet»sie»aktuell»und»kompetent»über»die»Trends»zu»innovativen»Technologien,»wirtschaftlichen»Rahmenbedingungen»und»
gesellschaftlichen»Entwicklungen.
www.vdi-nachrichten.com

DIE INSTANDHALTUNGS-AUSZEICHNUNG DES JAHRES: DER

Sie»haben»Bemerkenswertes»in»Ihrem»Instandhaltungsbereich»geleistet?»Dann»sollten»
Sie»am»Wettbewerb»um»den»»MAINTAINER 2016»teilnehmen!»Gesucht»werden»
wieder»die»besten»Instandhalter»des»Jahres»–»in»den»Kategorien:

1.» MAINTAINER»–»Projekt»des»Jahres/Industrieunternehmen

2.» MAINTAINER»–»Projekt»des»Jahres/Dienstleister

Darüber»hinaus»können»auch»Hersteller»von»Ausrüstungen»oder»Entwickler»von»
Anwendungen»ausgezeichnet»werden:

3.» MAINTAINER»–»Sonderpreis»für»Innovation

Unabhängig»davon,»ob»es»sich»um»eine»kleine,»innovative»Verbesserungsmaßnahme,»
eine»durchgängige»Instandhaltungskampagne,»das»am»besten»instandgehaltene»
Werk,»eine»neu»entwickelte»Dienstleistung»oder»ein»innovatives»Produkt»handelt»
–»alle»bemerkenswerten»Aktivitäten»haben»eine»Chance»auf»eine»Auszeichnung!

Mit»dem»MAINTAINER 2016»soll»die»Bedeutung»der»Instandhaltung»für»die»»betriebliche»
Produktivität»(vom»Kostenfaktor»zum»Wettbewerbsvorteil)»in»der»deutschen»Indus-
trielandschaft»stärker»in»den»Mittelpunkt»gerückt»werden.

Eine»Fachjury»aus»unabhängigen»und»hochkarätigen»Experten»kürt»in»jeder»K»ategorie»
den»Gewinner.»Die»Gewinner»in»den»jeweiligen»Kategorien»präsentieren»ihre»Projekte»
bzw.»Produkte»auf»der»Fachtagung»MAINDAYS 2016 am»16.»März»in»Berlin»in»einem»
jeweils»15-minütigen»Vortrag.»Zudem»werden»die»mit»dem»Award»»ausgezeichneten»
Projekte»im»Fachmagazin»„Instandhaltung“»ausführlich»vorgestellt.»Den»Gewinnern»
winken»eine»Trophäe»sowie»ein»Preisgeld.

Die»Bewerbungsunterlagen»können»Sie»per»Post»anfordern»oder»von»unseren»Web-»
seiten»herunterladen:»www.tacook.de/awards.»Einsendeschluss»ist»der»29.»Januar»2016.

MAINTAINER
2016

Gold-Sponsor MAINTAINER:

Projekt des Jahres/Dienstleister Weitere Sponsoren:

Medienpartner

Innovationspreis

www.b-und-i.de
www.chemanager-online.com
www.derbetriebsleiter.de
www.industrie40-management.de
www.vdi-nachrichten.com


1. Teilnehmer

Name,»Vorname

Funktion/Abt.

Telefon»» »» » E-Mail

Unterschrift

2. Teilnehmer

Name,»Vorname

Funktion/Abt.

Telefon»» »» » E-Mail

Unterschrift

Firma»

Branche

Straße

PLZ/Ort

Bitte bei abweichender Rechnungsanschrift ausfüllen:

Abteilung

Name

Straße

PLZ/Ort

Fax: +49 (0)30 88 43 07 30
Gern»können»Sie»sich»auch»online»anmelden»unter:
www.maindays.de

Anmeldung
MAINDAYS 2016 
16. – 17. März 2016, Berlin

Ich nehme teil

Bitte»benutzen»Sie»für»Ihre»Anmeldung»dieses»Formular»und»faxen»Sie»es»an:»

Teilnahmegebühr

Die»Teilnahmegebühr»beträgt»einschließlich»digitaler»Dokumentation,»Mittagessen,»
Pausenerfrischungen»sowie»einer»Abendveranstaltung»am»16.»März»2016:

Tagung, 2-tägig 1.590,– Euro zzgl. MwSt.
Workshop, 1-tägig 890,– Euro zzgl. MwSt.
Tagung und Workshop, 3-tägig 2.190,– Euro zzgl. MwSt.

Nach»Eingang»Ihrer»Anmeldung»erhalten»Sie»die»Teilnahmebestätigung,»die»Rechnung»
und»eine»Anreiseskizze.»Reise-»und»Übernachtungskosten»sowie»sonstige»Nebenkosten»
gehen»zu»Lasten»der»Teilnehmer.

Bitte»überweisen»Sie»den»Rechnungsbetrag»vor»Veranstaltungsbeginn.»Die»Teilnahme»
kann»nur»gewährt»werden,»wenn»die»Zahlung»eingegangen»ist.»Stornierungen»müssen»
schriftlich»zwei»Wochen»vor»Veranstaltungsbeginn»eingehen.»In»diesem»Fall»erheben»
wir»eine»Bearbeitungsgebühr»von»200,–»Euro.»Bitte»haben»Sie»Verständnis»dafür,»
dass»wir»bei»Nichteinhaltung»dieser»Frist»die»volle»Teilnahmegebühr»berechnen.»Im»
Verhinderungsfall»kann»selbstverständlich»eine»andere»Person»als»Ersatz»angemel-
det»werden.»Eine»Kombination»aus»unterschiedlichen»Rabatten»ist»nicht»möglich.
Etwaige»Programmänderungen»behalten»wir»uns»vor.

Veranstaltungsort/Lage

Ihr Veranstalter

T.A.»Cook»Conferences,»der»Tagungsbereich»von»T.A.»Cook»Consultants,»veranstaltet»
seit»mehr»als»zwei»Jahrzehnten»sehr»erfolgreich»Konferenzen»und»Seminare»zu»den»
Themen»Instandhaltung,»Ersatzteil-»und»Projektmanagement.»Regelmäßig»berichten»
Praktiker»und»Experten»renommierter»Unternehmen»bei»uns»über»innovative»Lösungs-
ansätze»in»den»Bereichen»Organisation,»Führung»und»Einsatz»moderner»Technologien.

Informieren»Sie»sich»über»aktuelle»Veranstaltungen»unter
www.tacook.de/veranstaltungen

Tagungsorganisation

T.A. Cook Conferences
Leipziger»Platz»1»und»2
10117»Berlin
Telefon»+49»(0)30»88»43»07-0
Telefax»+49»(0)30»88»43»07-30

MAINDAYS 2016
Ansprechpartnerin:»Jessica»Mann
E-Mail:»j.mann@tacook.com
www.maindays.de

Steigenberger Hotel Berlin 
Los-Angeles-Platz»1
10789»Berlin
Tel.:»+49»(0)»30»/»21»27-0
Fax:»+49»(0)»30»/»21»27-117

Übernachtung

Im»Tagungshotel»steht»ein»begrenztes»Zimmerkontingent»zur»Verfügung.»Bitte»nehmen»
Sie»die»Reservierung»direkt»im»Tagungshotel»unter»Bezugnahme»auf»unsere»Tagung»vor.

Mit»der»Anmeldung»zu»dieser»Veranstaltung»bestätige»ich,»die»Stornierungsbedingungen,»AGB»und»
Datenschutzbestimmungen»auf»www.tacook.com»gelesen»und»akzeptiert»zu»haben.

Early Bird bis 29. Januar 2016
1.450,–

790,–
1.990,–

 Tagung 16. – 17. März 2016

 Forum»
»  A oder»  B
»  C oder  D

  Ja, ich nehme an der Abendveranstaltung  
am 16. März 2016 teil.

  Workshop 15. März 2016 
Risikoorientiertes»Instandhaltungsmanagement»–»strategischer»
Erfolgsfaktor»für»Anlagenverfügbarkeit»und»Kostenoptimierung
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Augsburger Straße
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  Ich»kann»leider»nicht»teilnehmen,»möchte»aber»das»digitale»Konferenz-»
material»(Download)»gegen»eine»Gebühr»von»350,–»Euro»zzgl.»MwSt.»erhalten.

  Ich»bin»FVI-Mitglied.»Meine»Mitglieds-Nr.»lautet:»»

 Bitte»informieren»Sie»mich»über»Sponsoring-/Ausstellungsmöglichkeiten.

 Bitte»aktualisieren»Sie»meine»Adresse.

 Bitte»entfernen»Sie»mich»aus»Ihrem»Verteiler.


